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Learning objectives | Onsite installation, commissioning and validation

At the end of this lesson, you should be able to:

• Describe the steps required for the on-site 
commissioning and validation process.

• Be familiarized with the tools needed for online 
commissioning.

Onsite activities 

Site Gateway

Commissioning

Site validation 

Project delivery

Multisite

Validate Metered Energy Feature

Modbus Meters settings  

Metered Energy

Upgrade Dynalite Firmware
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Onsite installation | Prerequisites

To begin with Multisite system configuration make sure bellow steps are accomplished :

• All luminaires are installed, wired, and powered ON

• Sensors and user interfaces are installed and wired according to installation manuals

• Controllers are wired in the distribution board (Power & Dynet) and powered ON

• Basic checks are performed to ensure correct wiring to the controllers

• The customer IT network is successfully scanned using the Interact Connectivity Toolbox 

software

• PDDEG-S site gateway is connected to the cloud

• Interact Retail Install app is installed on the phone

• The work order is checked using the mobile app

• A Dynalite DTK-622USB PC Node is available

• The System Builder software is installed with an enabled Technician license

• The latest PDDEG-S firmware is downloaded from the Signify Partner Portal

Multisite
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Site gateway | Open Job file from the cloud

Login to the cloud

Connect the PC to the Internet and run System Builder

1. On the Tools menu, click Online Accounts

2. Click Add and select Retail Account

3. Select the Region and click OK

4. Select your account to login to. If required, fill in your password

5. Account has been linked with the Multisite cloud

Open job file from the cloud

6. On the File menu, click Open and select Open Job From Cloud

7. In the Work Order Selection menu, select the Region

8. Select the work order that belongs to the site, then click OK

Wait a moment until the file is successfully loaded

5
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Site gateway | Upgrade PDDEG-S

Localize and upgrade gateway

1. In the System view, select the PDDEG-S.

2. On the Tools menu, click Localize Devices by Sign-on.

3. Push the sign-on button on the gateway. In the Localize Device dialog box, click Localize.

4. Right-click the device and select Firmware Upgrade.

5. Select the new firmware file and click Start. Wait until the upgrade process is finished.
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Site gateway | PDDEG-S network configuration

Configure network settings 

1. In the System view, select the PDDEG-S

2. On the Ports tab, click Advanced to expand additional configuration options

3. Select one of the following:

         - Use static IP address to False, to obtain dynamic settings of the customer IT network

         - Use static IP address to True, to configure static IP and network settings manually.

           Always use static IP address configuring Metered Energy with PDEB/PDEG

4. With the Static IP set to True, manually set Gateway, Subnet mask, DNS server,                

and Alternative DNS server 

5. Right-click the device and select Save To Device. Select Resave all device data, click OK.

6. Right-click on the PDDEG-S and Send Device Reboot to apply new network configurations.

Save job file to the cloud

7.      Save modified job file to the Cloud. Make sure to use a proper Work Order

Wait until the file is successfully saved to the cloud. Observe progress in the Application logs
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Site gateway | Activate PDDEG-S 1/2

Establish connectivity:

1. Run the Interact Retail Install app, select the Region and relevant                                                                                             

Work Order

2. Tap Start commissioning

3. Tap Establish connectivity

2

3

4

4. Select Use available internet connection while using customer IT 

outbound connection

5. Select Set up 4G connectivity device, while  using  4G modem 

delivered by Signify. Follow further on-screen instruction

6. Tap Done          

    

5
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Site gateway | Optional 4G modem configuration

About the Modem:

1. Out-of-the-box connectivity device.

2. Equipped with an internal soldered SIM which is ready for use.

3. Includes the following accessories: a 1.5m Yellow Ethernet 

cable, 2 cellular antennas to provide optimum signal 

strength and 1 DIN rail mounting bracket

4. It requires 24V DC, 1.5A Power Supply which needs to be 

ordered independently.

5. At the back of each modem there's a sticker with a unique bar 

code which will be required by the Interact Retail Install app.

Multisite
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Advices:

1. Ensure you install the modem in an area with enough network coverage.

2. After the external power source is switched on, wait 2 minutes for 

confirming the modem connects to the mobile network.

3. The Vodafone MachineLink 4G Lite router uses eight LEDs to display the 

current system and connection status.

Onsite commissioning

Site gateway | Optional 4G modem configuration

Multisite
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Site gateway | Activate PDDEG-S 2/2

Activate gateway:

1. In the app, tap Assign site gateway

2. Check on PDDEG-S if the bottom led flashes:

• If so, tap Yes

• If not, tap No and follow the steps in the app

3. Scan the QR-code on the PDDEG-S

4. After reading the message Assigning in progress, tap OK

5. Wait for the gateway to be assigned. It can take up to 30 minutes
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Commissioning | Assign box numbers

With PDDEG-S gateway successfully assigned to the cloud, further commissioning 

process is handled in the System Builder software.

Assign box numbers to devices in the job file

1. In the System Builder, open the job file from the cloud.                                           

Make sure to use a proper Work Order.

2. Connect PC to the DyNet network

3. In the System view, select either load controller, user Interface, integration device 

or sensor

4. On the Tools menu, click Localize Devices by Sign-on

5. Push the sign-on button on the device. In the Localize Device dialog box, click 

Localize. Use sign-on by torch, or dedicated IR remote controller for sensors that 

are difficult to reach.

6. After successful box number assignment re-save configuration to the device.

7. Repeat steps for all devices in the DyNet network. 

4
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Commissioning | Configure DALI

DALI individual addressing (DDBC120-DALI, DDBC320-DALI)

When all DALI ballasts are enumerated for a selected controller:

1. On the Outputs tab (A), map the Physical Channels (B) to the 

correct Child areas (C) and Logical Channels (D)

2. In the column Base Link Area (E), map the number of the         

Child area (C) with the Parent Area. Reflect Project Template and 

the IAR Cloud configuration

3. Calculate and fill in the Load (F) in Watts and select the Power 

Category (G) of the physical channel

4. Right-click the device and select Save To Device. Select Resave all 

device data and click OK

5. Repeat for other DALI individual addressing devices

Onsite commissioning
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Commissioning | Finalize configurations

Configure sensors

Most of the sensor configurations are finalized during the Offsite preparation, and have been described in 

the previous module:  System Builder | Additional configurations – Sensors 

Offsite configurations are already saved to the physical devices.

During Onsite installation:

• While using DALI sensors make sure to enumerate these devices and assign correct box numbers.

• While using Daylight harvesting feature make sure to calibrate all involved sensors.

• Validate if the sensors work as expected.

• Remember to always use Resend Inhibit Period for motion detection functionality.

Configure user interfaces

Most of the sensor configurations are finalized during the Offsite preparation, and have been described in 

the previous module:  System Builder | Additional configurations – User Interfaces

Offsite configurations are already saved to the physical devices.

• During Onsite installation please validate if the user interfaces work as expected

Multisite
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Commissioning | Additional configurations – Alarm Integration

Integrate Alarm, via the Dry Contact Inputs (DDMIDC8)

The Dry Contact interface, can provide integration with Alarm systems.

Specific configuration must be followed, to enable this functionality.

To integrate with an external Alarm system:

1. IAR Multisite Manual 2-Hour Override and Alarm Integration Task 

must be applied on PDDEG-S

2. Dry Contact Input used for the Alarm integration should be configured 

with a Custom function, and Join Byte 0x85

3. Configure following input actions:

• Start task 5 on the PDDEG-S device, when the Alarm is being armed

• Start Task 4 on the PDDEG-S device, when the Alarm is being disarmed

2

1

Alarm disarmed
3

Alarm armed

Multisite
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Commissioning | Save SB job file to the cloud

Save final job file to the cloud

1. Make sure System Builder is connected to the Multisite account

2.     On the File menu, click Save As and select Save Job To Cloud

3.     In the Work Order Selection menu, select the Region: Europe

4.     Find and choose applicable work order, then click OK

Wait until the file is successfully saved to the cloud. Observe progress in the Application logs.

1
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While using Modbus RS485 architecture :

o Update PDDEG-S firmware version to 1.23 or higher.

o Upgrade PDEG/PDEB firmware version to 3.58 or higher.

o Upgrade DDNG485v3 firmware version to the latest version.

Modbus Meter settings:

o Configure Meter Address and Baud Rate (supported Baud Rates are : 9600, 19200, 38400).

o Configure other Data Format parameters as follow: Half-duplex, Data bits 8, Parity None, Stop bits 1.

o Ensure IP Address on the Modbus Meter equals IP address configured on the Meter in System 

Builder.

o Ensure Port specified on the Modbus Meter equals port configured on the Meter in System Builder.

o Verify general electrical configurations and if applicable configure Current Transformers ratio.

Onsite commissioning

23

Multisite metered energy | Additional configurations

Multisite
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Multisite metered energy | Onsite validation

1. In the System view, click on the Modbus Meter.

2. Go to Modbus Configuration Editor tab.

3. Right click on the Active Energy register and select Request 

Register Value.

4. Confirm that Register Value is being populated. Verify 

against expected consumption.

5. Observe SB network logs and confirm that Binary Metric 

Data is being generated every 15 minutes.

Note: Approximately after 1 hour the Metered Energy data will 

start to be presented in the Customer`s dashboard.
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Site validation | Mobile app

Validate Areas, Child Areas and Logical Channels

1. In the app, tap Validate site installation

2. Tap the name of a Parent Area

3. Tap the name of  a Child Area

4. Tap the name of a Logical Channel

5. Tap the buttons and check visually if the lights respond accordingly. 

Correct if necessary.

6. When the lights respond as expected, tap Yes, confirm

Repeat for all existing Parent Areas, Child Areas and Logical Channel

Make sure Site, Areas, Child Areas and Logical Channels are validated →  
 

1 2
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6

✔️
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Site validation | Mobile app

Deploy and validate concepts and schedules

Please make sure, that the default concept and schedule

are prepared in the cloud during Offsite preparation

1. In the Tasks page, tap Deploy concept and schedule

2. Tap Yes, confirm, to deploy default concept and schedule

3. Tap Validate concept and schedules

4. Tap the name of a Parent area

5. Tap the buttons and check visually, if the lights respond accordingly. 

Correct if necessary.

6. When the lights respond as expected, tap Yes, confirm

Repeat for all other Parent areas. Make sure to validate all Areas → 

1 2
3
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✔️
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Project delivery | Mobile app

On the successful  Site validation, all the Tasks are completed and marked as 

Resolve work order

1. Tap Resolve work order

2. Tap Yes, confirm to resolve the work order

3. Work order changes the state to Resolved

1

2

3

✔️

Congratulations !!! 

Site is ready to use ! 

Multisite
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Project delivery | Customer handover

With the IAR Multisite System fully commissioned , Site-Engineer delivers the project                    to 

the Market organization.

It is up to the Market to plan the final handshake with the Customer, either on-site or remotely.

For the successful handover:

1. Make sure a user account is created for the customer (OTRS ticket)

2. User has an appropriate role assigned of the Format or the Facility Manager (OTRS ticket)

3. Print out the latest User Guide document.                                                                                                                 

This document can be found on the Signify Partner Portal or directly in the cloud Dashboard

4. Based on the User Guide train the Customer on how to use our system.

Engage with the Customer using a monthly generated report. 

Use this opportunity to discuss further projects and gain feedback on our system.

3
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Lesson review | Onsite installation, commissioning and validation

In this lesson, you:

• Explored the four steps to be taken in the on-site commissioning and validation process
• Site gateway configuration: saving and upgrading the bridge through System Builder, 

and establish connectivity through the Interact Retail Install app.
• Commissioning: resaving the final System Builder project to the cloud after localizing 

and saving all devices on the network, including the individual DALI physical channels 
when needed.

• Optional configuration for energy metering
• Site validation: divided into validation and deployment of both schedule and concept.
• Hand over to the end user: which requires to resolve the work order.

• Got familiarized with the tools required for onsite commissioning.

Multisite
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